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In This Version 

The HP Operations Smart Plug-in for IBM WebSphere Application Server for HP Operations Manager for 
UNIX contains new features, feature enhancements, and other changes. 

New Features 

• Support for distributed network deployer scenario for WebSphere Application Servers 7.00 

• PMI Counter is not supported for WebSphere Application Server version 6.0 and above 

• Support for HP Operations Manager i (HP OMi) 8.10. For more information on how the SPI 
works with HP OMi, see HP Operations Manager i 8.10 documentation. 

• Enhanced log file monitoring 

• Enhanced error logging  

• Implemented monitoring of discovery and collector error logs 

• Replaced the Discover WebSphere and Configure WBSSPI tools with a single tool Discover or 
Configure WBSSPI tool to enable both discovery and configuration 

• Enhanced Configuration Editor 

• Support for HP Operations Manager for UNIX 9.0x 

• Introduced golden metrics that monitor the basic functionality of the WebSphere Application 
Server 
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• Added the following new metrics for monitoring JVM, EJB, ThreadPool, and Connection Pool 

Metric Name Description 

I807_JVMMemFreePct Percent of JVM Free Memory available 

I808_JVMCpuUsagePct The CPU Usage of the Java virtual machine 

I809_GCIntervalTime The average garbage collection value in seconds 
between two garbage collections 

I810_MsgBackoutRate The rate at which the messages failed to be delivered 
to the bean onMessage method (message driven 
beans) 

I811_ReturnDiscardRate The rate at which the returning object was discarded 
because the pool was full (entity and stateless) 

I812_ThrdPoolHungRt The rate at which the threads are declared hung 

I813_CncrntThrdPoolHngCt The number of concurrently hung threads 

I814_PrprdstcachdiscrdRt The rate at which the prepared statements are 
discarded by the least recently used (LRU) algorithm 
of the statement cache 

• Removed the following metrics: 

— WBSSPI_0003 

— WBSSPI_0004 

— WBSSPI_0803 

— WBSSPI_0804 

— WBSSPI_0805 

For information about customer-related enhancements and software fixes, see Enhancements and Fixes. 

Documentation Updates 

The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version.  

• Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to:  

http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 
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NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site: 
http://www.adobe.com/

Installation Notes 

Installation requirements, as well as instructions for installing the WebSphere SPI, are documented in the 
Installation and Configuration Guide for HP Operations Smart Plug-in for IBM WebSphere Application 
Server provided in Adobe Acrobat (.pdf) format. The document file is included on the product's DVD media 
in the documentation directory.

Software and Hardware Support  

Refer to the Support Matrix (SUMA) link 
http://support.openview.hp.com/selfsolve/document/KM323488 for the supported HP Operations 
Manager, application servers, HP Performance Agent, HP Performance Manager, and HP Reporter version.  

For information on the archived obsolescence programs, refer to the Obsolescence Archive link 
http://intranet.hp.com/tsg/WW2/SWObsoMigrations/ObsoArchive/Pages/ArchivedObsoPrograms.a
spx. 

Upgrade Notes 

Be aware of the following limitations when you plan to install the WebSphere SPI 7.00 from SPI DVD 2009 
on a HPOM 9.0x, which has the WebSphere SPI 6.00 installed from SPI DVD 2008. 

• You must complete the migration process from HPOM 8.xx to HPOM 9.0x before upgrading the 
WebSphere SPI to version 7.00. Once the WebSphere SPI 7.00 is installed, migrating from HPOM 8.xx is 
not supported. 

• You must take the backup of the content in the /opt/OV/wasspi/wbs directory before upgrading the 
SPI to the version 7.00, in case you want to reuse the old content. When you upgrade the SPI to the new 
version, the old content in the /opt/OV/wasspi/wbs directory will be lost permanently. 

• Having the WebSphere SPI version 6.00(migrated from HPOM 8.xx) and WebSphere SPI version 
7.00(newly installed from SPI DVD 2009) on HPOM 9.0x is an intermediate mode and you must move all 
managed nodes to the WebSphere SPI version 7.00 as soon as possible. 

• If you have multiple SPIs deployed on a managed node, the node can be monitored either by SPI DVD 
2008 SPIs or SPI DVD 2009 SPIs. Monitoring a node by combination of SPIs from SPI DVD 2008 and 
SPI DVD 2009 is not supported. 

• If you have the WebSphere SPI 7.00 installed on HPOM 9.0x systems, which also has the WebSphere 
SPI 6.00 as well, the following points are true. 

— You must configure newly added managed nodes using the WebSphere SPI 7.00. 

— No configuration is possible on the existing or old managed nodes monitored by the WebSphere SPI 
6.00. 

This is because the WebSphere SPI 6.00 configuration tools are overwritten by the WebSphere SPI 7.00 
tools and these tools are incompatible. 

• Patches for the WebSphere SPI version 6.00 must be installed before you start the HPOM migration 
process. Once the WebSphere SPI version 7.00 is installed, no patches or hot-fixes pertaining to the 
WebSphere SPI version 6.00 could be installed on the HPOM server. 
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• To invoke the GUIs related to WebSphere SPI 7.00, you must install X-windows client software on the 
machine from which you will launch the HPOM for UNIX 9.0x server Operator GUI. 

• Installing patches that would be released in the future for the WebSphere SPI version 6.00 are not 
supported on HPOM for UNIX 9.0x after migration. However, patch can be installed on the HPOM for 
UNIX 8.xx server and migrated to HPOM for UNIX 9.0x environment. 

• Migration of Java Metric Builder (JMB) to HPOM for UNIX 9.0x server is not supported. 

• Graph templates cannot be invoked from automatic action or Operator initiated action of alerts. 

• After migration from HPOM 8.xx to HPOM 9.0x, when you run license reporting tool from HPOM 9.0x, 
the following errors would be reported. This is an expected behavior. You can ignore this error. 

ERROR: (oprel-407) License status for 'SPI Name' is: Error 

Can't check license status because of missing ID mapping file. 

Please install the missing component and make sure that a 

sufficient number of licenses is installed. 

Error: '(oprel-130) ID mapping file does not exist: (oprel-129) 

Can't find ID mapping file '/opt/OV/misc/EL/registration/<SPIname>.xml' 

for plug-in '<SPIname>'. ' 

ERROR: (oprel-407) License status for 'SPI Name remote' is: Error 

Can't check license status because of missing ID mapping file. 

Please install the missing component and make sure that a 

sufficient number of licenses is installed. 

Error: '(oprel-130) ID mapping file does not exist: (oprel-129) 

Can't find ID mapping file '/opt/OV/misc/EL/registration/<SPIname>.xml' 

for plug-in '<SPIname>'. ' 

Enhancements and Fixes 

To display details about each software enhancement or fix, click the reference number link to go to the HP 
Software Online Support web site. The first time you click a link, you must enter your HP passport 
information. To set up your passport profile, go to: 

http://h20229.www2.hp.com/passport-registration.html

Fixes  

QXCR1000785668: < 5.10><WEBSPHERE 6.0 ><OVOW/WIN2003> <WIN2003><SystemOut.log 
errormessage> 

QCCR1A90228: Documentation defect for PMI Counters for UDM

QCCR1A89015: OMi Support Required for WBSSPI 

QCCR1A92743: WBSSPI 6.x collector not working in non ND mode 

QCCR1A91990: wasspi_wbs_files wbstextlogs shows repeated files in the command output 

QCCR1A99355: Documentation Defect : Metric 220-225 do not work due to specific bean is not installed 

Known Problems, Limitations, and Workarounds 

This release contains the following unresolved problems. Workarounds are provided wherever applicable. 
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• Limitation: The metrics WBSSPI_0220 to WBSSPI_0225 returns a valid value only if Entity Beans are 
present in the application(s) deployed on the WebSphere Application Server(s). 

• Problem: If the instrumentation files of more than one Web Application Server SPI are deployed on the 
same node, an error message (File name collision detected) appears in the HPOM message browser 
whenever a multiple occurrence of an instrumentation file is identified. 

• Problem: When the instrumentation files of the WebSphere SPI and SHS component are deployed on 
the same node, an error message (File name collision detected) appears in the HPOM message browser 
whenever a multiple occurrence of XMLParser.pm is identified. This does not affect the configuration. 
You can ignore this error message. 

• Problem: In a Network Deployer scenario, the time taken for the discovery and the collection process to 
complete is delayed if one or more federated nodes are configured to the deployment manager.  

• Problem: Two or more versions of the WebSphere application server are running on a managed node 
and discovery does not correctly set the properties for the application server(s). 

Workaround 1:   

1 Verify the application servers are using non-conflicting ports. If you install an application server in a 
different home directory, the installer may choose a port used by an existing application server (even if 
you set the installer to auto-configure non-conflicting ports). 

2 If application servers are using the same bootstrap port, modify the port numbers so that each 
application server uses a unique bootstrap port. 

3 Run the Discover tool. 

Workaround 2:  If you want to use the same bootstrap port, run the Discover or Configure WBSSPI tool 
and do the following: 

1 Set the HOME, JAVA_HOME, VERSION, and other properties that are incorrectly set. 

2 Set a unique ALIAS for each application server using the same port. 

3 Select Finish. 

• Problem: In a non-English environment, the message browser does not display error messages 
correctly. 

Workaround:  Change the character set of the WBSSPI Error Log template and redeploy the template. 
For example, change the character set from “Shift-JIS” to “Japanese EUC.” 

• Problem: When the Self-Healing Info tool is run on a Windows managed node, the output file may be 
hidden. 

Workaround:  If you do not see the file, do the following on the managed node: 

1 Open Windows Explorer. 

2 From the Tools menu, select Folder Options.  

3 Click on the View tab.  

4 Under Hidden files and folders, select Show hidden files and folders. 

• Problem: The perl installed with the HPOM agent fails to find the HPOM perl modules if another 
application (such as Oracle Application Server) sets the PERL5LIB environment variable to point at 
locations that do not include the HPOM perl lib location.   

Workaround 1: Set the PERL5LIB system environment variable: 

1 Prepend C:\Program Files\HP OpenView\nonOV\perl\a\lib (the HPOM perl lib path) to the 
PERL5LIB system environment variable.  

2 Kill the HPOM agent: opcagt -kill  
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3 Restart the HPOM agent: opcagt -start  

4 Check the HPOM environment: ovdeploy -cmd set  

5 If the PERL5LIB variable is not set correctly in the HPOM environment but the system variable is set 
correctly, reboot the system. 

Workaround 2:  

1 Delete the PERL5LIB system environment variable.  

2 Reboot the system. 

3 Run the Discover tool. 

Workaround 3: Run the discover script on the target node. Enter the following: 

1 cd /var/opt/OV/bin/instrumentation 

2 wasspi_perl –S wasspi_wbs_discovery.pl 

NOTE: The service map is not generated when the discover script is run locally (is not run from the 
HPOM management server). 

• Problem: The wbs.log file grows very large.   

Workaround: Limit the size of the data saved to the log file each time the logfile encapsulator is run. In 
the SPIConfig file (located in /var/opt/OV/wasspi/wbs/conf/ or /var/opt/OV/conf/wbs/ on 
UNIX platforms and /usr/OV/wasspi/wbs/conf/ on Windows platforms), add the following: 

# maximum number of lines to save to the log file / run 
LOG_LINE_LIMIT=16667 
# maximum number of characters to save from each log file / run 
LOG_SIZE_PER_FILE_LIMIT=600000 

• Problem: The Web browser cannot be launched from an operator action after you have correctly 
configured the WBSSPI as instructed in the “Configure the Management Server to Launch your Web 
Browser” task in chapter 2 of the HP Operations Smart Plug-in for WebSphere Application Server 
Installation and Configuration Guide.  

Workaround: 

1 Stop and restart the agent from a user other than root by entering the following commands on the 
managed node: 

opcagt –kill 
opcagt –start 

2 Run the operator action. 

• Problem: Netscape fails to refresh graphing data. Specifically, when you use Netscape as the browser to 
graph your data (graphing capability included with Reporter 3.0 or higher), the browser fails to refresh 
when new selections are made.  

For example, in the HPOM console after you drag and drop a managed node onto the WBSSPI Admin 
tool View Graphs, Netscape appears and displays a blank WBS SPI graphing page where you can accept 
or change the following default selections: 

Server: MyServer_1

Graph Name:  Serverstat

Data Range: 7 Days (ending now) 

By clicking Draw, you successfully generate the graph.  

However, when you select a different server, let’s say MyServer_2, you see that the graph that appears 
after you click the Draw button is the same graph/data as the one you just viewed (for MyServer_1). 
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Workaround: 

1 In Netscape from the Edit menu select Preferences•
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2 In the segment labeled Document in cache is compared to document on network, select radio button 
Never. 

3 After successfully generating the first WBSSPI graph, for any subsequent graphs, always change a 
minimum of two selections to refresh the data; for example select a different server and a different 
graph; or select a different graph and a different date range. Any two differing selections work to clear 
the current graph data from the browser cache. 

NOTE: The underlined text Refresh Graph Now at the bottom of the Web page does not work; when 
clicked, it may return the error: the parameter is incorrect. 

• Problem:  On a Solaris managed node, the ddflog and dsilog processes hang. The error message  

WASSPI-1: Unable to create the lock file /var/opt/OV/wasspi/wbs/datalog/ddflog.lck. File 

already exists. is reported and running the command ps –l shows that the ddflog_coda and ddflog or 
dsilog processes are hung. 

Workaround: On each Solaris managed node on which the problem occurs, do the following: 

1 In the /var/opt/OV/wasspi/wbs/conf/SPIConfig file, set the DATA_LOGGING_EXECUTABLE_NAME property 
after the “#--------- Dynamic definitions -----------“ entry. DATA_LOGGING_EXECUTABLE_NAME explicitly sets 
the data logging program that is used (normally, the collector automatically determines the data logging 
program to use). 

If you are running OVPA, set the property to the following value: 

DATA_LOGGING_EXECUTABLE_NAME=/opt/perf/bin/dsilog 

If you are running CODA, set the property to the following value: 

DATA_LOGGING_EXECUTABLE_NAME=/opt/OV/bin/OpC/monitor/ddflog_coda 

2 Kill the hung ddflog_coda and ddflog or dsilog processes. 

Example excerpt from the SPIConfig file after setting the property: 

UDM_GRAPH_CAPACITY=50000 
UDM_PERF_CAPACITY=50000 
#--------- Dynamic definitions ----------- 
DATA_LOGGING_ENABLED=TRUE 
DATA_LOGGING_EXECUTABLE_NAME=/opt/perf/bin/dsilog 

• Problem: On Linux nodes, the Discover or Configure WBSSPI tool can fail without configuring the SPI 
on the managed Linux node.  This happens because some of the configuration processes require 
uudecode to be present on the local node. 

Workaround:  Ensure that uudecode is installed on the target managed node.  It is available in the 
SHARUTILS package. 

• Problem: The "Start WebSphere" and "Stop WebSphere" tools fail on Windows nodes if the USER or 
SERVER<n>_USER configuration property is set.  The tool is trying to run the "su" command, which is 
only available on UNIX. 

Workaround:  Do not set the USER or SERVER<n>_USER property when configuring the 
SERVER<n>_START_CMD or SERVER<n>_STOP_CMD properties for Windows nodes. 

• Problem: For a managed node running Red Hat Linux 4, discovery and/or metric threshold monitor 
alarming is not functioning AND the following error message is found in the SPI error log: 

*** glibc detected *** double free or corruption: 0x0937d008 *** 

Workaround:  On the HPOM agent, set the MALLOC_CHECK_ environment variable to 0 (zero) and restart 
the agent. 

• Problem: The output of Check WebSphere tool displays date format in English, in all locales. 
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There is no workaround for this problem, in the current release. 

• Problem: The Discovery times out on the node in a network deployer scenario.  

Workaround: Change the value for timeout for agtrep on the node. 

1 Run the following command: ovconfchg –edit. 

2 Change the value of ACTION_TIMEOUT to a higher value so that Discovery does not timeout. 

For example: Change ACTION_TIMEOUT=3 to ACTION_TIMEOUT=20 (or more minutes). 

Documentation Errata 

• The information in the WBSSPI 7.00 documentation is applicable only to the HP Operations Manager 
for HP-UX 9.00. 

• You must take the backup of the content in the /opt/OV/wasspi/wbs directory before upgrading the 
SPI to the version 7.00, in case you want to reuse the old content. When you upgrade the SPI to the new 
version, the old content in the /opt/OV/wasspi/wbs directory will be lost permanently. 

• The following troubleshooting information is missing in the Installation and Configuration Guide for HP 
Operations Smart Plug-in for IBM WebSphere Application Server. 

Problem: In the SiteConfig file for Windows managed nodes, the value for HOME and JAVA_HOME 
appears as:  

HOME=CProgram FilesIBMWebSphereAppServer 
JAVA_HOME=CProgram FilesIBMWebSphereAppServerjava 

The "\" character is removed from the path. 

Workaround: Replace the character "\" with "/" or "\\" in the path for HOME and JAVA_HOME. 

For example, HOME=C:/Program Files/IBM/WebSphere/AppServer  or  
HOME=C:\\Program Files\\IBM\\WebSphere\\AppServer

Local Language Support 

The SPI installers obtain the HPOM for UNIX locale from the ctrl.env namespace before proceeding with the 
SPI installation. Verify if the namespace has been set using the following command: 

# /opt/OV/bin/ovconfget ctrl.env LANG  

If the ctrl.env namespace is not set by the HPOM, run the following command on the HPOM Server before 
starting the SPI installation: 

# ovconfchg -ns ctrl.env -set LANG <HPOM locale> where <HPOM locale> could be C, ja_JP, 
ko_KR, or zh_CN 

Example: ovconfchg -ns ctrl.env -set LANG ja_JP

Depending on the <HPOM locale> value, the LANG variable in the ctrl.env namespace will be set to C.utf8, 
ja_JP.utf8, ko_KR.utf8, or zh_CN.utf8. 
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Support 

You can visit the HP Software support web site at: 

www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valued support 
customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html

Legal Notices 

©Copyright 2009 Hewlett-Packard Development Company, L.P. 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

For information about third-party license agreements, see the spi-thirdparty-license-agreements directory on 
the product installation DVD-ROM. 
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Trademark Notices 

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. 
Windows® is U.S. registered trademarks of Microsoft Corporation.  
Java™ is a US trademark of Sun Microsystems, Inc.  
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